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1	 INTRODUCTION

From Scan to CAD in no time
Bring physical parts into digital parametric CAD models with a reverse-engineering software that combines history-based CAD 

with 3D scan data processing. Geomagic® Design X™ is the industry’s most comprehensive reverse engineering software, com-

bines history-based CAD with 3D scan data processing so you can create feature-based, editable solid models compatible with 

your existing CAD software.

What Can You Do with Geomagic Design X?
Geomagic Design X converts 3D scan data into high-quality, feature-based CAD models. The software combines automatic and 

guided solid model extraction in a unique way while being incredibly accurate.

Scan virtually anything and create producible designs.

•	 Rebuild CAD data for broken tools and molds.

•	 Recreate lost CAD data for parts and molds.

•	 Design custom products.

•	 Convert physical parts into CAD for new product designs.

•	 Make existing parts fit with new parts.

INTRODUCING GEOMAGIC® DESIGN X™ 
Version 2022
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2	 INSTALLATION

System Requirements
For the latest system requirements information and to learn about specific qualified system configurations, go to the System 

Requirements page in the Geomagic Support Center. Some users have had success running system configurations that deviate 

from the supported listed on our website. In such cases, these configurations are not officially supported by Oqton.

Additionally, we test a variety of hardware platforms in combination with the graphics subsystems. While we make every attempt 

to be as thorough as possible, hardware manufacturers change their products frequently and may be shipping newer products 

or have discontinued active support for others. Check the support section of the website for the latest system requirement 

information and specific qualified systems.

Download and Install software
You can download and install the software from support.3dsystems.com/s/software-support-3dsystems, select the Geomagic 

Design X product, then select to download Geomagic Design X.

In addition, automatic software updates are available if you set the Update Product Automatically option to True in Preferences 

and a valid maintenance code is activated, and your computer is connected to the Internet. The application will check if a newer 

version is available and will download it automatically for installation.

You can also manually check if a newer version is available by going to Help > Check For Update.

Activate License
Geomagic Design X requires license activation to run the application on your PC. You can choose to use a trial license for a 15-day 

period or activate a permanent license. 

After you start your application, the License Manager window opens. The License Manager allows you to activate and use the 

Geomagic Design X software. 

NOTE: When the License Manager is launched, you can click the Help  button found at the top right corner of the window 
to read the CimLM Licensing Guide.  

You should have received an email from Oqton with your activation code. If you have not received an email from Oqton, visit the 

Contact Us page at: https://support.3dsystems.com/s/contact-support-page, and find the details to contact the support team 

depending on your product and region.

For more information, go to the CimLM Licensing Support page.

https://support.3dsystems.com/s/article/Geomagic-System-Requirements
https://support.3dsystems.com/s/article/Geomagic-System-Requirements
http://support.3dsystems.com/s/software-support-3dsystems
https://support.3dsystems.com/s/article/CimLM-Licensing-Support
https://support.3dsystems.com/s/contact-support-page
https://support.3dsystems.com/s/article/CimLM-Licensing-Support
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3	 NEW FEATURES AND ENHANCEMENTS

Improvements to Loft
Achieve the intended design by utilizing advanced modeling options.

CHALLENGE:
There needs to be more options to control tangency for guide curves and 

to define connectors so that the user has more control over the loft feature 

definition.

SOLUTION:
Tangency to Faces
A new Tangency To Face option has now been 

added, allowing you to control tangency for 

selected guide curves. 

Note: This option is available only for surface 
bodies.

Connector Editing Tools
New Connector Editing Tools have been added to 

the Loft command. You can now add, delete, and 

edit connectors to control over influence of lofted 

surface.

Improvements to Exact Surfacing
Save time by reusing auto-surface patch networks when creating surface patches manually. 

CHALLENGE:
There needs to be a new option to keep patch networks 

created by auto-surfacing for later surface patch works.

SOLUTION:
A new Keep Patch Network in the Tree option has been 

added to the Auto Surface command, allowing you to 

keep patch network created by auto-surfacing for later 

manual surface patch works.

What’s New In 2022.0.0
New features in this release were made to deliver more efficient, and new workflows for complex designs. They also improve the 

speed of modeling of today’s more common and challenging parts. This release also includes major enhancements and various 

bug fixes to make your experience easier and comfortable.

Note: The  label indicate features that are also available in Geomagic Design X Essentials software package.
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LiveTransfer To Latest CAD Software Versions
The following CAD applications are now supported in LiveTransfer:

•	 SOLIDWORKS 2022 (Now supported for SOLIDWORKS 2006 to 2022)

•	 Inventor 2021, 2022, and 2023 (Now supported for Inventor 2010 to 2023)

•	 Creo 8.0 (Now supported for Creo up to 8.0)

•	 Creo Parametric 4.0 M150 (Now supported for Creo Parametric up to 4.0 M150)

•	 NX 1899 series (Now supported for NX 8 to 1899)

Additionally, the LiveTransfer to SOLIDWORKS has been improved so that the custom templates set in the SOLIDWORKS 

application can be used when transferring models to SOLIDWORKS.

System Options in SOLIDWORKS

Improvements to Sketch Tools
Increase productivity by using improved sketching tools. The following improvements were made to the Sketch tools:

New Centered Rectangle

The new Centered Rectangle command has been added as a new sketch entity type. This command allows you to quickly create 

a rectangle from a center point on a sketch plane. 
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Fit Polyline Option for Rectangle

The Fit Polyline option is available for Rectangle. You can now fit a rectangle to selected polyline just in a second.

Snap Sketch to Another Sketch

You can now drag and snap selected sketch entities to another sketch entities. 

Midpoint Constraint

The Midpoint constraint is now available between line/arc and point.

Note: Creating the mid point constraint is available only for line and arc sketch types.

Snap Sketch to Reference Point

You can now drag and snap a sketch to 3D reference points regardless of the view orientation of the sketch plane.
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Replace Target Mesh

You can now reuse an existing mesh sketch by replacing with a new target mesh. 

Converted Sketch

The entity conversion has now been improved for circle so that the geometry of a converted circle has the same  

geometry as an original circle. 

Tangent Magnitude for 3D Spline

You can now specify the tangent magnitude for 3D spline.
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Display Type for Circular Dimension

You can now choose the display type of circular dimensions when dimensioning circular entities. Changing the display type is also 

available in the Properties of circular sketch entities. This supports selection for multiple circular entities.

Smart Diameter Radius

Note: After adding circular dimensions, the display type of the 
circular dimensions can be changed in the Properties.

Split 2D Sketch Entity

Split lines, arcs, and splines. You can now split a 2D sketch entity at intersection points of selected sketch entities by using a new 

Curves At Intersection Point option added to the Split command.
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New Hexagon Structured Light Scanner Interface
Geomagic Design X offers the Scanner Direct Control that enables the use of various scanning devices directly within the 

application.

CHALLENGE:
Enable to use the Hexagon Structured Light 

Scanners within Geomagic Design X.

SOLUTION:
A new Plug-In for Hexagon Structured Light 
Scanners has newly been implemented. You 

can now connect Hexagon Structured Light 

Scanner Interface and directly scan objects in 

Geomagic Design X without using the Optocat 

application.

CAD Tessellated Mesh Segmentation
Increase productivity of downstream operations such as alignment and modeling with improved quality and faster performance 

of region segmentation for a mesh tessellated from CAD.

CHALLENGE:
The quality of region segmentation needs to be improved for a mesh tessellated from CAD.

SOLUTION:
A new Region Segmentation algorithm has been implemented, improving the quality of region segmentation for a mesh 

tessellated from CAD. A newly added CAD Tessellation Mesh option allows you to achieve a high quality of region segmentation 

for CAD mesh models.

Geomagic Design X 2022.0.0 Geomagic Design X 2020.0.4
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Hardware Interface Updates
The following hardwares are now supported in Scanner Direct Control and LiveCapture:

•	 Scanner Direct Control
•	 Shining 3D Einscan scanner

This is available in the following location: Insert > Scanner Direct Control > Shining3D

•	 LiveCapture
•	 Leica AT960 tracker + Absolute AS1 scanner

This is available in the following location:  
Hexagon Absolute in LiveCapture

Note: The Romer Absolute device has now been renamed "Hexagon Absolute". To use the Leica Absolute Scanner, 
select Hexagon Absolute on the Device List in LiveCapture.

•	 Faro Quantum Max/S + LLP XR/HD
This is available in the following location:  
FaroArm/ScanArm in LiveCapture
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Auto-Save & Recovery
The new options for supporting auto-save and recovery working files have newly been added. These options allow you to more 

safely protect your working files from unexpected application crashes.

Note: In case of application crash, you will receive a notification and can decide the following operations:

Yes: Browse to the location of the auto-saved files.

No: Discard reviewing the auto-saved files.

Cancel: Keep them to review at the next launch .

File Import
Native CAD File Import has been updated to support the following versions:

CAD Application File Extension Version Supported Comments

CATIA V5 .catpart, .catproduct R8 - V5-6 R2021 Geometry Only

CATIA V6 .catpart, .catproduct Up to V6 R2021x Geometry Only

Creo (Pro/E) .prt, .prt.*, .asm, .asm.* Pro/E 16 – Creo 8.0 Geometry Only

Inventor .ipt, .iam V6 - 2022 Geometry Only

SIEMENS NX .prt 11 – NX1980 Geometry Only

SOLIDWORKS .sldpt, sldasm 98-2022 Geometry Only (2016-2021)

STEP .stp, .step AP203, AP214, AP242 Geometry Only

AutoCAD DXF .dxf 2.5 - 2022 Geometry Only

Save Design in Rolled Back State
Save the file in a rolled back state. Continue to work without having to roll the working state to the end to save a file.
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Improvements to Accuracy Analyzer
The following improvements were made to the Accuracy Analyzer:

Normal Vector Filter

A new Normal Vector Filter option has now been added to the Accuracy Analyzer. This allows you to ignore the normal direction 

of target measurement bodies while analyzing deviations for body.

Reference Mesh for Comparison

You can now choose the reference mesh for deviation comparison.
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Improvements to Smart Selection Tool
Increase productivity due to efficient and quick selection of adjacent areas with similar curvature and angles.

CHALLENGE:
There needs to be improved the smart region selection results.

SOLUTION:
Improved the smart selection results. You can add or remove disjointed area to the selection by using SHIFT and CTRL keys 

respectively. The Smart Selection tool now also works on point cloud. Thus, you can achieve higher productivity due to efficient 

and quick selection of adjacent areas based on similar curvature and angles on the scan entity.  

Click Click + Drag Up Click + Drag Down

3D Mouse
In the 3DConnexion application, you can configure 3D mouse settings for Geomagic Design X.
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Miscellaneous Enhancements
•	 Feature name

•	 Used the feature to name a created body, e.g., <Mesh Fit> instead of <Imported Body 1> when creating a surface using 

the Mesh Fit command.

•	 Retained the model’s name when converting solid/surface body to mesh.

•	 Retained the model’s name when importing neutral CAD files such as STL, IGES, and Parasolid files to the application.

•	 Feature can be renamed by right-clicking on it and click Rename.

•	 The model name is used as the default file name when exporting solid or surface bodies.

•	 Assign different colors to scans - A new Align Different Colors option has been added to the ScanData tab of the LiveCapture 

Settings. While scanning with the LiveCapture, obtained scans are added with different material colors.

•	 View clip
•	 The View Clip can now be set from the selection expanded to regions, mesh, and CAD entities.

•	 New options for editing and resetting View Clip have now been added to the Context Menu. You can edit the View Clip 

by clicking the options in the Context Menu.
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•	 Show selected entities only
The applicable scope of the Show Selected Only option has been expanded to a selected area on a mesh.

•	 Easy access to visibility controls
You can now easy to turn on or off the visibility of entities from the Upper-Side Toolbar.

 

•	 Transform geometries
You can now select reference geometries and move them while aligning scan data. Due to the new Select Geometries to 
Move option, any probed reference geometries can now be bound to the scan data and moved together.
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•	 Continue scanning / probing - When clicking the ‘B’ button on a measuring device to stop scanning or probing, you can now 

decide whether to continue with the current operation, or to stop and proceed to the next operations.

Continue Scanning Continue Probing

•	 Large data handling
Improved the performance of large scan data handling.

•	 Export surface or solid bodies via Batch Process
You can now design a batch process to allow to export solid and surface bodies selectively.

•	 Repositioned Import command
The Import command has now been relocated under the File menu for a better understanding of the design workflow.
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 Licensing & Installer
The following improvements were made to the Licensing System and the Installer:

•	 The language that was set in the previous version is retained when the user auto-updates to the newer version.
•	 The licensing system has been more robust to prevent activation errors and lost licenses in some cases.

•	 Rotation center
You can easily set the rotation center of the view by middle-clicking on any point on the Model View.

•	 Capture screen
•	 Dimension texts can also be captured with entities.

•	 The last used values are remembered for later use.
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4	 BUG FIXES

Bug Fixes in 2022.0.0
This section lists issues that have been resolved since Geomagic Design X v2020.0.4:

Note: The  label indicate features that are also available in Geomagic Design X Essentials software package.

Common
•	 GDX-7534: In the Accuracy Analyzer, strange deviation results were made depending on the normal direction of target 

faces of a reference surface body.
•	 GDX-7480: Clearing area selections were not reflected in the dialog tree when using the Mesh Fit or the Loft Wizard 

command.

•	 GDX-11218: 

The following issues were found when using the Customize Ribbon command.

•	 Commands that did not exist in the current Ribbon menu were in the list of the Customize Ribbon Menu 
and they were not removed from the list.

•	 When adding a command to the custom Ribbon menu, the list collapsed and the command could not 

be added to the list.
•	 GDX-6823: When disconnecting a second monitor, the Preferences window working on the second screen didn’t move to 

a connected screen.
•	 GDX-13515: 

When turning the Sound options off in the Preferences, it continued to work in non-English locales.

•	 GDX-13414:
When clicking Probing operation in the LiveCapture without clicking the ‘B’ button on a connected scanner, 

scans obtained with the Laser Scanning operation were not added to the Feature Tree.
•	 GDX-15628: When capturing entities on a second monitor with different screen resolutions, the size of the entities was 

captured differently.
•	 GDX-7739, 

GDX-7849, 
GDX-11274, 
GDX-15178: 

When capturing sketch entities, dimensions were excluded from the captured screens.

•	 GDX-16569, 
GDX-16373: Only a user with an administrator privilege could launch the application for the first time.

•	 GDX-3618, 
GDX-892, 
GDX-14117: 

In the 2D Sketch, the maximum zoom-out was limited to 250mm by default. As a result, it was not allowed to 

select an entire sketch if its size was too large to be viewed in the max zoomed-out Model View.

•	 GDX-16060, 
GDX-14187: Entity selection and deselection were sometimes possible with the right mouse button.

•	 GDX-15977: 
The application would crash on launch with multiple PCs.

•	 GDX-15202: 
Activation errors came up when activating the application with a license used in an old version of CimLM. 

The following workarounds are recommended to avoid this issue: 

•	 Update the license on a new version of the License Utility

•	 Deactivate and reactivate the license on a new version of the License Utility
•	 GDX-15246: The default keyboard shortcuts didn't remain when resetting keyboard shortcuts; only custom shortcuts need 

to be removed when resetting.
•	 GDX-13567: The Small Icon Only option applied to individual commands in the Customize Ribbon command didn't 

remain as it applied after clicking on the menu.
•	 GDX-15773: 

The application would crash after a few seconds.



Oqton, Inc. 18

•	 GDX-15929: 
There were the wrong guides in the Mouse Helper.

•	 GDX-16066: 
 

When clipping the view by using the Set View Clip From Selection command, a clipping box that was too 

tight to control was created. As a result, many unexpected flickering issues occurred while manipulating the 

clipping box.

Sketch Tools 
•	 GDX-13845, 

GDX-15190, 
GDX-15632: 

When changing a target scan data to reuse existing sketches for a new scan data, the section polyline 

always took into account the original scan data.

•	 GDX-16672, 
GDX-11984: The Pierce constraint was not available between a point and an existing 2D sketch outside the sketch plane.

•	 GDX-16297: The application would crash when adding a constraint between a helix curve and a point.

•	 GDX-16299: 
The selection of end-points of a copied sketch didn't remain after copying from an existing sketch.

Scan / Mesh Tools   
•	 GDX-12212: 

The value in the Reduction Ratio input box in the Decimate command didn't remain as it was entered.

•	 GDX-12921:

When re-entering the following commands with the preselected area by using the Ctrl + Spacebar shortcut 

key, the selection became changed inversely.

•	 Defeature 
•	 Enhance Shape
•	 Smooth 
•	 Offset

•	 GDX-14307: 
The application would crash while running the Global Remesh command if the target mesh had a texture.

•	 GDX-16611: The application became unresponsive when applying the Merge or the Combine command to meshes or 

point clouds exceeded a certain number.

•	 GDX-13349:
The Rolling Radius status in the Normal Information Wizard command didn’t roll back to the previous status 

when undoing.
•	 GDX-8373, 

GDX-13320:
Changes were not discarded on click of the Cancel button after applying the Normal Information Wizard 

command to selected poly-faces.

•	 GDX-15294: Cracks were found on the mesh as the result of the Offset command.

•	 GDX-15666: 
The Min. Edge Length option in the Convert To Mesh command didn’t affect the result.

•	 GDX-15663: Scan data disappeared off the screen after scan data processing on AMD Ryzen Threadripper 3990X and 

AMD Ryzen Threadripper PRO 3995WX Procesor.
•	 GDX-14664: 

The Fill Holes command would work only when all selected holes were fillable.

•	 GDX-11073: Failed to trim a mesh with a 3D mesh sketch in certain cases.

•	 GDX-13457:
After separating a mesh that was imported with Double poly-vertex precision, the precision was suddenly 

changed to Float.

Modeling Tools
•	 GDX-14783: When applying a new fillet radius to an edge of a model while using the Variable Fillet, the fillet didn’t 

update with the new radius value.
•	 GDX-2255: Failed to apply the Extrude with the Result Operators (Cut and Merge) to the model imported from a 

Parasolid file.
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•	 GDX-13205:
The number of spline points in the second stage was always fixed at 5 when running the Loft Wizard for the 

first time regardless of the Smoothness rate.

•	 GDX-13413:
Could not go to the second stage in the Loft Wizard when the No. of Sections was set to 2 with the By Curve 

path.
•	 GDX-16674, 

GDX-16674:
When using the Datum Alignment method in the Transform Body command, there were many geometric 

regions and CAD faces that could not be selected depending on the relationship between Datum pairs.
•	 GDX-16622, 

GDX-16293: Could not change the position of a loft connector on a circle profile with no endpoint.

•	 GDX-16741: When clearing some of the selected composite profiles in the Loft command, the preview disappeared and 

the command became inapplicable.

•	 GDX-16521: The application would crash when rebuilding a path curve in the Sweep Wizard command.

•	 GDX-16625: When the Constant Width option was selected for the Face Fillet in the Fillet command, the Radius option 

didn't change to "Width".

Exact Surfacing
•	 GDX-12317, 

GDX-12128: 
The Extend Boundaries option didn’t work when applying the Auto Surface with the Selective Surfacing and 

the Boundary Smoothing Iterations options. This sometimes caused the application to crash when going to 

the second stage.

•	 GDX-12013: 
After applying the Auto Surface with the Selective Surfacing and the Fill Trimmed Boundary Only options, 

an error message appeared that says the surface fitting failed, and a trimmed mesh containing many 

defects was created.

•	 GDX-11893:
The application would crash when clicking Update to reanalyze defects after readjusting high-deviation 

patches in the Repair Patches command.
•	 GDX-11751, 

GDX-4057, 
GDX-9830:

After editing a patch network manually, wrong patch groups were detected in the Shuffle Patch Groups 

command.

•	 GDX-11439: The application became unresponsive while creating a curve network by using the Selective Surfacing 

options in the Auto Surfacing command.

Region Tools
•	 GDX-15297: Applying the Auto Segmentation with high sensitivity would cause the application to be slow.

•	 GDX-13478, 
GDX-4369:

The Mesh From CAD or CAE Software option in the Auto Segment command didn't work properly. The 

region segmentation algorithm has now been improved for CAD tessellated mesh and this option has been 

renamed "CAD Tessellated Mesh".
•	 GDX-14948: 

The application would crash when applying a custom viewpoint to a mesh with regions.

Hardware Interface
•	 GDX-2670, 

GDX-724, 
GDX-233, 
GDX-3128: 

The 3dconnexion SpaceMouse didn't work in Geomagic Design X.

•	 GDX-17063: The application would crash while probing with Creaform Optical CMM in LiveCapture.

•	 GDX-17061, 
GDX-17324:

The calibration optimization didn't work for Creaform Portable 3D Scanners.

•	 GDX-17315: Scanning didn't work while Creaform's VXelements application was closed.
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LiveTransfer
•	 GDX-15242: The Use Custom NX Execution File Path option in the LiveTransfer to NX command didn't work properly.

•	 GDX-13974: Failed to transfer a model to Creo 6.0.

•	 GDX-15244: LiveTransfer to Creo 7.0 or later versions continued to stop due to many pause errors.

•	 GDX-15229: Failed to transfer surface bodies created by the Mesh Fit command to Creo 7.0

•	 GDX-12310: Failed to transfer a model to NX 1847.

File I/O
•	 GDX-15148, 

GDX-14273, 
GDX-14498, 
GDX-12319: 

Failed to import .E57 files into the application.

•	 GDX-2683: 
The application became unresponsive when importing certain Parasolid files.

•	 GDX-13060: 
When saving point clouds with colors as an .XRL file, the colors were excluded from the file.

•	 GDX-12998: 
A mesh saved as an .XDL file was always imported into the application as a point cloud.

•	 GDX-13664, 
GDX-11569, 
GDX-10750:

After running the Run Mesh Buildup Wizard on import for multiple mesh files, the original meshes were listed 

on the Model Tree, but not shown in the Model View.

•	 GDX-11978:
The application would crash when clicking Skip to skip all the remaining steps of the Mesh Buildup Wizard 

that ran when importing scan files.
•	 GDX-15654, 

GDX-15626: Failed to import an .OBJ file with textures into the application.

•	 GDX-11533: 
Failed to import an .CXProj file saved in the old version of Geomagic Control X into the application. 

•	 GDX-16065: 
The application would crash on import for certain files.

•	 GDX-16596: 
Failed to open an .XRL file in certain cases.

•	 GDX-16695, 
GDX-16982: Failed to import large scan data and became unresponsive on load in certain cases.
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Known Issues in 2022.0.0
This section lists known issues that need to be addressed for next versions:

•	 GDX-17093:
After transforming scan data with reference geometries by using the Transform Scan Data command, the 

labels of the reference geometries are still in their original position.

•	 GDX-17250: 3D patch network created by auto-surfacing is not transferred to SOLIDWORKS.

•	 GDX-17114:
The center point of a centered rectangle is not selected by the Select All command or the Ctrl + A shortcut 

key, and still remains after deletion. To delete the remained point, select it and delete by going to Edit > 
Delete or pressing the Delete key.

•	 GDX-17092:
When scaling the size of scan data by using the Transform Scan Data command, the size of the reference 

geometries that are selected with the target scan data is scaled accordingly. The size of the reference point is 

incorrect only during the previewing stage. The size becomes correct after running the command.

•	 GDX-17316:
When transforming scan data with reference geometries by using the Transform Scan Data command, 

the Estimate button in the Select Geometries To Move option doesn't work for the geometries that are not 

visible in the Model View.

•	 GDX-17231:
The start point of the loft connector isn't fixed on the node point of a curve. It depends on the properties of 

the curve.
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